Training document for the company-wide automation solution

Totally Integrated Automation (TIA)

MODULE D5

PROFIBUS DP with

Master CPU 315-2DP / Slave ET 200S
This document was provided by Siemens A&D SCE (automation and drive technology, Siemens A&D Cooperates with Education) for training purposes. Siemens does not make any type of guarantee regarding its contents.

The passing on or duplication of this document, including the use and report of its contents, is only permitted within public and training facilities.

Exceptions require written permission by Siemens A&D SCE (Mr. Knust: E-Mail: michael.knust@hvr.siemens.de). Offences are subject to possible payment for damages caused. All rights are reserved for translation and any case of patenting or GM entry.

We thank the company Michael Dziallas Engineering and the instructors of vocational schools as well as further persons for the support with the production of the document.
The following symbols stand for the specified modules:

- Information
- Programming
- Example exercise
- Notes
1. FORWARD

The module D5 is assigned content wise to Industrial field bus systems.

Learning goal:

In this module, the reader should learn how the PROFIBUS DP is taken into operation with the CPU 315-2DP as a master and the ET 200S with the integrated CPU as a slave. The module shows the principle procedure by means of a short example.

Requirements:

For the successful use of this module, the following knowledge is assumed:

- Knowledge in the use of Windows 95/98/2000/ME/NT4.0
- Basics of PLC- Programming with STEP 7 (e.g. Module A3 - ‘Startup’ PLC programming with STEP 7)
- Basics of the PROFIBUS DP (e.g. Appendix IV – Basics of field bus systems with SIMATIC S7-300)
Required hardware and software

1. PC, Operating system Windows 95/98/2000/ME/NT4.0 with
   - Minimal: 133MHz and 64MB RAM, approx. 65 MB free hard disk space
   - Optimal: 500MHz and 128MB RAM, approx. 65 MB free hard disk space

2. Software STEP 7 V 5.x

3. MPI-Interface for the PC (e.g. PC-Adapter)

4. PLC SIMATIC S7-300 with the CPU 315-2DP with at least one digital in- and output.
   Example configuration:
   - Network: PS 307 2A
   - CPU: CPU 315-2DP
   - Digital inputs: DI 16x DC24V
   - Digital outputs: DO 16x DC24V / 0.5A

5. Distributed I/O ET 200S with integrated CPU and with at least one digital in- and output.
   Example configuration:
   - PROFIBUS connection with integrated CPU: IM 151/CPU
   - Power supply: PM-E DC24V
   - Digital inputs: 4 DI DC24V
   - Digital outputs: 4 DO DC24V / 0.5 A

6. PROFIBUS cable with 2 PROFIBUS slots
2. NOTES FOR THE OPERATION OF THE CPU 315-2DP

The CPU 315-2DP is a CPU that is made available with an integrated PROFIBUS DP interface. For the CPU 315-2DP, the following PROFIBUS protocol profiles are available at your disposal:
- DP- Interface as a master or slave in accordance with EN 50170. PROFIBUS-DP (Distributed I/O) is the protocol profile for the connection of distributed I/O/Field equipment with fast reaction time.

A further characteristic is that the addresses of the in- and output modules can be parameterized by this CPU.

The CPU capability is given with the following data:
- 16K statements. 48Kbyte RAM (integrated) 80Kbyte RAM
- 1024 Byte DI/DO
- 128 Byte AI/AO
- 0.3 ms / 1K Instructions
- 64 Counters
- 128 Timers
- 2048 memory bits

Note: The CPU 315-2DP is appointed here on the PROFIBUS as a master.

3. NOTES TO THE OPERATION OF ET 200S/CPU

The ET 200S/CPU is a distributed I/O system with a modular configuration and an integrated CPU. The ET200S/CPU functions as a slave to the PROFIBUS DP.

The PROFIBUS address is adjusted by a binary coded DIL-switch block. Another possible adjustment of the PROFIBUS address is with the power recovery. Therefore, the ET 200S must be turned off and then back on.

The CPU capability is given with the following data:
- 8K Statements. 24Kbyte RAM (integrated) 40Kbyte RAM
- 128 Byte DI/DO
- 128 Byte AI/AO
- 0.3 ms / 1K Instructions
- 64 Counters
- 128 Timers
- 2048 Memory bits
4. COMMISSIONING THE PROFIBUS (MASTER CPU315-2DP / SLAVE ET200S/CPU)

In the following example, the commissioning of a mono master system with the CPU315-2DP as a master and an ET 200S as a slave is described.

For the testing of the configuration, a program will be written in which a display lamp H1 is triggered by the simultaneous activation of the switch S0 by the CPU 315-2DP and the switch S1 by the ET 200S/CPU.

Assignment list CPU 315-2DP:
- I0.0  S0  Switch S0
- Q10.0 Comm_Q1  Output communication Bit1

Assignment list ET 200S/CPU:
- I10.0 Comm_I1  Input communication Bit1
- I1.0  S1  Switch S1
- Q2.0  H1  Display lamp

1. The central tool in STEP 7 is the SIMATIC Manager, which is opened here with a double click (→ SIMATIC Manager).
2. STEP 7- Programs are administered in projects. Such a project will be created (→ File → New).

3. Give the **Name ET200S** to the project (→ ET200S → OK).
4. Highlight your project and insert a **PROFIBUS Subnet** (→ ET200S → Insert → Subnet → PROFIBUS).

5. Then insert a **SIMATIC 300-Station** (→ Insert → Station → SIMATIC 300-Station).
6. Modify the name of the station to **ET200S** (→ ET200S).

7. Open the configuration tool for the **Hardware** with a double click (→ Hardware).
8. Open the hardware catalog with a click on the symbol \( \rightarrow \). There you will see the directories are divided into the following:
- PROFIBUS-DP, SIMATIC 300, SIMATIC 400 and SIMATIC PC Based Control,
  all module racks, modules and interface modules for the projection of your hardware
configuration are made available.
Insert IM151/CPU with a double click ( \( \rightarrow \) PROFIBUS-DP \( \rightarrow \) ET 200S \( \rightarrow \) IM151/CPU ).
9. By the entering of the slave, the following window appears, in which you assign a PROFIBUS address. This address must be adjusted identical with the address by the ET200S (→ 3 → OK)
10. Now all modules can be chosen out of the hardware catalog and inserted into the configuration table and are also inserted into your real ET200S.

To insert, you must click on the name of the respective module, hold the mouse button and Drag & Drop the module into a line of the configurations table.

We begin with the power module PM-E DC24V, which is dropped into slot 4. (→ PROFIBUS-DP → ET 200S → IM151/CPU → PM-E DC24V)

![Image of configuration table]

Note: If your hardware differs from what is shown above, then you must select the appropriate modules from the catalog and insert them into the rack. The part numbers of the individual modules, which are found on the components, are indicated in the footer of the catalog.
11. In the next step, we drop the digital input module 4 DI DC24V into the fifth slot. There the order number and version of the module can be read (→ PROFIBUS-DP → ET 200S → IM151/CPU → 4 DI DC24V).
12. In the next step, we drop the digital output module 4 DO DC24V/0.5A into the sixth slot. There the order number and version of the module can be read. The configuration table is saved and compiled now with a click on \( \text{Save} \). Then the hardware configuration is closed with a click on \( \text{Finish} \)

\( \text{PROFIBUS-DP} \rightarrow \text{ET 200S} \rightarrow \text{IM151/CPU} \rightarrow 4 \text{ DO DC24V/0.5A} \rightarrow \text{Save} \rightarrow \text{Finish} \).

13. In the SIMATIC Manager a further SIMATIC 300 Station is inserted for the CPU 315-2DP

\( \text{SIMATIC Manager} \rightarrow \text{Insert} \rightarrow \text{Station} \rightarrow \text{SIMATIC 300-Station} \).
14. Modify the name of the station to **CPU315_2DP** (→ CPU315_2DP).

15. Open the configuration tool for the **Hardware** with a double click (→ Hardware).
16. Open the hardware catalog with a click on the symbol \( \rightarrow \). There you will see the directories are divided into the following:
- PROFIBUS-DP, SIMATIC 300, SIMATIC 400 and SIMATIC PC Based Control,
all module racks, modules and interface modules for the projection of your hardware
configuration are made available.
Insert a **Rail** with a double click (\( \rightarrow \) SIMATIC 300 \( \rightarrow \) RACK-300 \( \rightarrow \) Rail).

![Diagram of hardware catalog and rail insertion]

After the insert, a configurations table for the configuration of the Rack 0 appears automatically.
17. Now all modules can be chosen out of the hardware catalog and inserted into the configuration table and are also inserted into your rack. To insert, you must click on the name of the respective module, hold the mouse button and Drag & Drop the module into a line of the configurations table. We will begin with the power supply PS 307 2A (SIMATIC 300 → PS-300 → PS 307 2A).

**Note:** If your hardware differs from what is shown above, then you must select the appropriate modules from the catalog and insert them into the rack. The part numbers of the individual modules, which are found on the components, are indicated in the footer of the catalog.
18. In the next step, we drop the CPU 315-2DP into the second card location. This allows for the part number and version of the CPU to be read off. (→ SIMATIC 300 → CPU-300 → CPU 315-2DP → 6ES7 315-2AF03-0AB0 → V1.1).

![Image of CPU configuration window]

19. By the entering of the CPU, the following window appears, in which you assign a PROFIBUS address to the CPU 315-2DP and must already choose the first PROFIBUS net. When you want to alter the parameter of the PROFIBUS net, you must highlight it and then click on Properties (→ Properties).

![Image of PROFIBUS interface properties window]
20. Now you can choose the **Highest PROFIBUS Address** (here → 126), the **Transmission Rate** (here → 1.5 Mbit/s) and the **Profile** (here → DP). (→ OK).

![Properties - PROFIBUS](image)

21. In the next step we see the input module for 16 inputs on fourth slot place. There the order number of the module is read off the front (→ SIMATIC 300 → DI-300 → SM 321 Di16xDC24V).

Note: Slot number 3 is reserved for interface modules and remains empty. The order number of the module is displayed in the footer of the catalog.
22. In the next step we see the output module for 16 outputs on fifth slot place. There the order number of the module is read off the front (→ SIMATIC 300 → DO-300 → SM 322 DO16xDC24V/0.5A).

Note: The order number of the module is displayed in the footer of the catalog.
23. Then a bar chart for the **Master system** is shown to the right of the CPU315-2DP, in which you can arrange the PROFIBUS. This happens by clicking the desired module (Here the **ET200S/CPU as Configured Stations**) from the hardware catalog in path **ET200S/CPU**. By Drag & Drop click with the mouse, it can be dropped into the master system (→ PROFIBUS DP → Configured Stations → ET 200S/CPU).
24. By the entering of the ET 200S/CPU as a slave, the following window is displayed in which you must **Connect** the already projected slave (PROFIBUS- Address 3) to the CPU 315-2DP (master) (→ Connect).

25. After the connection, the ET 200S is entered as an active connection. This connection is then accepted with **OK** (→ OK).
25. With a double click, the entered (3) ET200S/CPU by the master system is selected (→ (3) ET200S/CPU).
27. In the following dialog, the data range can be adjusted for the communication between the ET200S/CPU and the CPU 315-2DP.

**From CPU 315-2DP to ET200S/CPU:**
Mode: Master/Slave
Output range CPU 315-2DP: Q10; Length 1 word; Consistency by the unit of a word
Input range ET 200S/CPU: I10; Length 1 word; Consistency by the unit of a word

**From ET200S/CPU to CPU 315-2DP:**
Mode: Master/Slave
Output range ET 200S/CPU: Q10; Length 1 word; Consistency by the unit of a word
Input range CPU 315-2DP: I10; Length 1 word; Consistency by the unit of a word
This adjustment is then accepted with OK (→ OK).
28. The configuration table should first be saved and compiled with a click on ![image](click1.png). Then the hardware configuration is closed with a click on ![image](click2.png) (→ ![image](click3.png) → ![image](click4.png)).

29. From the **SIMATIC Manager**, open the block **OB1** for the **ET200S** with a double click (→ **OB1**).
30. Optional: Enter the properties of the OB1 for documentation and accept with OK (→OK).
31. With LAD, STL, FBD: **Program blocks**, you now have an editor which gives you the possibility to generate your STEP 7-Program. Here the organization block OB1 was already opened with the first network. In order to generate your first logical operation, you must highlight the first network. Now you can write your first STEP 7-Program. Several programs can usually be divided into networks. Open a new network by clicking on the network symbol  

The STEP 7-Program to be tested can now be saved with  

32. From the **SIMATIC Manager**, open the block **OB1** for the **CPU315_2DP** with a double click  

(→ OB1).
33. Optional: Enter the properties of the OB1 for documentation and accept with OK (→OK).

![Properties - Organization Block](image_url)

34. With LAD, STL, FBD: Program blocks, you now have an editor which gives you the possibility to generate your STEP 7- Program. Here the organization block OB1 was already opened with the first network. In order to generate your first logical operation, you must highlight the first network. Now you can write your first STEP 7- Program. Several programs can usually be divided into networks. Open a new network by clicking on the network symbol. The STEP 7- Program to be tested can now be saved with (→ ).

![LAD/STL/FBD - OB1](image_url)

**Note**

After the transferring of the hardware configuration, the master CPU315-2DP searches for your slave and also the slave ET200S awaits the master call. It is important to generate the organization blocks OB82 and OB86 in both CPUs.
35. **In SIMATIC Manager**, the **Set PG/PC Interface** controls the download of the data into the CPU 315-2DP (→ Options → Set PG/PC Interface).

36. Chose the **Properties** of the interface parameterization for the **PC Adapter(MPI)** (→ PC Adapter(MPI) → Properties).
37. Choose the setting of the local connection.

38. Choose the MPI setting and accept with OK (\rightarrow OK \rightarrow OK).
39. In **SIMATIC Manager**, load the station **CPU315_2DP** into the PLC. The mode switch of the CPU must be on STOP and the PC-Adapter must be connected with the MPI-Interface of the CPU 315-2DP! 

40. In **SIMATIC Manager**, the **Set PG/PC Interface** changes for the downloading of the data into the ET 200S/CPU on to the PROFIBUS ( → Options → Set PG/PC Interface).
41. Choose the **Properties** of the interface parameterization for the **PC Adapter(PROFIBUS)** (→ PC Adapter(PROFIBUS) → Properties).

![Set PG/PC Interface window](image)

42. Choose the setting of the local connection.

![Properties - PC Adapter(PROFIBUS)](image)
43. Choose the **PROFIBUS** setting and accept (→ OK → OK).

![PROFIBUS settings](image)

44. In **SIMATIC Manager**, download the station **CPU315_2DP** into the PLC. The switch on the ET200S/CPU must be on STOP and the PC-Adapter must be connected with the PROFIBUS interface of the CPU 315-2DP! Also the CPU 315-2DP must be connected again over the PROFIBUS with the ET 200S/CPU (→ ET200S).

![SIMATIC Manager](image)

45. Now switch the ET200S/CPU to RUN. If it starts up, then the program can be started through the switching of the mode switch on the CPU 315-2DP to RUN.